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  Introduction
Introduction
Cisco ViewMail for Microsoft Outlook provides a visual interface with which users can send, listen to, 
and manage their Cisco Unity Connection voice messages from Outlook.

Users can be set up with ViewMail to access their voice messages by using IMAP or by using the 
Connection single-inbox feature (synchronization of Connection and Microsoft Exchange mailboxes). 
Note the following considerations with ViewMail for Outlook:

Requirements
• The ViewMail for Outlook version must be supported with the version of Outlook that is installed 

and the operating system. (See the “ViewMail (With Connection 8.5 and Connection in Cisco 
Unified CMBE 8.5)” section of Compatibility Matrix: Cisco Unity Connection and the Software on 
User Workstations at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclientmtx.
html.)

• The following software installed on the user workstation:

– Microsoft DirectX

– Microsoft .NET Framework 3.5

– Microsoft Visual C++ 2008 Redistributable Package

(If the software is not already installed, ViewMail for Outlook Setup installs it.)

• To install or upgrade ViewMail for Outlook, you must have local administrator rights on the user 
workstation.

• The user workstation must have at least 10 MB of hard-disk space available for ViewMail for 
Outlook. (If other required software is being installed,100 MB or more may be required.)

• Cisco Unity Connection versions 8.x and 7.x support ViewMail for Outlook 8.5(3).

See also the “Prerequisites” section on page 7 of these release notes.

Single-inbox users • Users get voice messages in the same Inbox as their email.

• Voice messages sent from Outlook do not appear in the Sent Items folder.

• ViewMail for Outlook is not required with the single-inbox feature. Without 
it, however, users can only play voice messages; they cannot compose, reply 
to, or forward them.

• ViewMail for Outlook is required for users to play secure messages in the 
Exchange mailbox.

IMAP users • Users get voice messages in a separate mail folder in Outlook.

• ViewMail for Outlook is required for users to play secure messages in the 
Connection mailbox.
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  Related Documentation
Compatibility Information
• For information on all qualified version combinations of ViewMail for Outlook, Cisco Unity 

Connection, and the software on user workstations, see Compatibility Matrix: Cisco Unity 
Connection and the Software on User Workstations at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclientmtx.
html. The document also contains the support policy for software on user workstations.

• For a list of all languages available for ViewMail for Outlook, see the “Available Languages for 
Cisco Unity Connection Components” section of System Requirements for Cisco Unity Connection 
Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html
. (Localized versions of ViewMail for Outlook 8.5 are expected to be released in the February-March 
2011 time frame.)

Determining the ViewMail for Outlook Version

To Determine the ViewMail for Outlook Version in Use from Outlook

In Outlook on the user workstation:

Related Documentation
For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the 
Documentation Guide for Cisco Unity Connection Release 8.x. The document is shipped with 
Connection and is available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/roadmap/8xcucdg.html.

Note The Quick Start Guide for Cisco ViewMail for Microsoft Outlook (Release 8.5 and Later) is available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.
html. (Note that the guide will be available by December 21, 2010.)

New and Changed Requirements and Support—Release 8.5(3)
This section contains information about new and changed requirements and support in the 8.5(3) release 
time frame only.

Outlook 2010 On the ViewMail tab, select About Cisco ViewMail.

Outlook 2007 and 2003 From the Help menu, select Cisco ViewMail for Outlook > About Cisco 
ViewMail.
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  New and Changed Requirements and Support—Release 8.5(3)
(For information on new and changed requirements and support in earlier versions of Cisco Unity 
Connection ViewMail for Microsoft Outlook, see the applicable release notes at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.)

Additional Languages for ViewMail for Outlook

Note Localized versions of ViewMail for Outlook 8.5 are expected to be released in the February-March 2011 
time frame.

The following languages were added with this release:

• Catalan

• Chinese-Hong Kong

• Finnish

• Greek

• Norwegian

For a list of all languages available for ViewMail for Outlook, see the “Available Languages for 
Cisco Unity Connection Components” section of System Requirements for Cisco Unity Connection 
Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html.

Cisco ViewMail for Microsoft Outlook 8.5(3) Versioning Explained
Field-test versions of ViewMail for Outlook version 8.5 were versioned “8.5(1)” and “8.5(2).” To ensure 
that field-test sites do not have problems upgrading to the release version, it has been numbered “8.5(3).”

Support for Multiple Languages Installed on a Workstation
With version 8.5(3), users can install ViewMail for Outlook in multiple languages on their workstations.

Users select the language in which they use ViewMail from the Language list in the ViewMail for 
Outlook Options/Settings dialog. Note that when a new language is selected, users must restart Outlook 
for the change to take effect.

In earlier versions, ViewMail for Outlook could be installed in only one language at a time on a user 
workstation. If a second language was installed, the first language was automatically uninstalled.

Support for Use with Multiple Voicemail Servers
ViewMail for Outlook 8.5(3) allows each of a user’s email accounts in Outlook to be associated with a 
voicemail server.

When a user has multiple email accounts set up in his or her Outlook profile, each account may be 
associated with a different voicemail server. For example, a user could have an IMAP email account 
associated with a Connection 8.0 server and a Microsoft Exchange email account associated with a 
Connection 8.5 server.
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  New and Changed Functionality—Release 8.5(3)
Support for Use with Synchronized Connection and Exchange Mailboxes 
(Single Inbox)

ViewMail for Outlook 8.5(3) is supported for use with synchronized Connection and Exchange 
mailboxes (single inbox) in Cisco Unity Connection 8.5.

The single-inbox feature provides an alternative to using IMAP to access Connection voice messages.

Note For Cisco Unity users who have been migrated to Connection and are using the single-inbox feature, old 
Cisco Unity voice messages are presented in Outlook inboxes as email messages with WAV attachments.

New and Changed Functionality—Release 8.5(3)
This section contains information about new and changed functionality in the 8.5(3) release time frame 
only.

(For information on new and changed functionality in earlier versions of Cisco Unity Connection 
ViewMail for Microsoft Outlook, see the applicable release notes at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.)

Configuration File for Setup Customization
The file AdminConfig.xml is available in the ViewMail for Outlook installation folder. The file can be 
used to prepopulate user and voicemail server information whenViewMail for Outlook installation is 
being pushed out to users.

Initialization Wizard
The Cisco ViewMail for Outlook Initialization wizard starts the first time Microsoft Outlook runs after 
ViewMail is installed on a user workstation and there is no existing information about an IMAP account 
or Exchange account associated with a voicemail server.

The wizard runs on a per-Outlook-profile basis and prompts the user for any required server or user 
information that has not already been prepopulated for the selected account. (See also the “Configuration 
File for Setup Customization” above.) 

Note that when users’ Outlook profiles have email accounts that are not already associated with a 
voicemail server, users can manually start the Initialization wizard to associate those accounts. (In 
Outlook 2010, on the ViewMail tab in the Help group, select Initialize Cisco ViewMail. In Outlook 2007 
and 2003, from the Help menu, select Cisco ViewMail for Outlook > Initialize Cisco ViewMail.)

However, when users want to change ViewMail for Outlook settings/options for an account already 
associated with a voicemail server, they should use the Account Settings dialog and not the Initialization 
wizard.

If users manually start the wizard and there are no available email accounts to associate with a voicemail 
server, they will see the message “All accounts have been associated with voicemail servers.”
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  Installation and Upgrade Information
Secure Messages
Users can compose secure messages by using ViewMail for Outlook 8.5(3) with Cisco Unity Connection 
version 8.5.

For information on setting up secure messaging in Connection, see the following documentation:

• The “Secure Messages in Cisco Unity Connection 8.x” section in the “Setting Up Features and 
Functionality That Are Controlled by Class of Service in Cisco Unity Connection 8.x” chapter of 
the User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx.htm
l.

• The “Securing User Messages in Cisco Unity Connection 8.x” chapter of the Security Guide for 
Cisco Unity Connection Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/security/guide/8xcucsecx.html.

ViewMail Improvements
ViewMail for Outlook 8.5(3) features an improved user interface, including new audio controls that 
replace the Media Master.

In addition, getting diagnostics is easier. ViewMail gathers log files, zips them, and attaches the .zip file 
to an email that you address and send.

Installation and Upgrade Information
• Task List for Installing ViewMail for Outlook 8.5 for the First Time, page 6

• Task List for Upgrading to ViewMail for Outlook 8.5, page 7

• Prerequisites, page 7

• Downloading ViewMail for Outlook 8.5(x), page 10

• Customizing ViewMail for Outlook Setup, page 11

• Installing or Upgrading to ViewMail for Outlook 8.5, page 11

• Associating the Applicable Email Account with the Voicemail Server, page 11

Task List for Installing ViewMail for Outlook 8.5 for the First Time
Do the following tasks in the order listed for a new ViewMail for Outlook installation.

1. Confirm that ViewMail requirements and prerequisites have been met. See the “Requirements” 
section on page 2 and the “Prerequisites” section on page 7.

2. Download ViewMail for Outlook from the Cisco Download Software website. See the 
“Downloading ViewMail for Outlook 8.5(x)” section on page 10.

3. Optional: Customize ViewMail for Outlook setup. See the “Customizing ViewMail for Outlook 
Setup” section on page 11.

4. Optional: Provide users with ViewMail for Outlook files for installation.
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  Installation and Upgrade Information
5. Install ViewMail for Outlook. Provide users with instructions, if applicable. See the “Installing or 
Upgrading to ViewMail for Outlook 8.5” section on page 11.

6. Link users’ email accounts with the voicemail server:

a. Using the ViewMail for Outlook Initialization wizard: When they restart Outlook following 
ViewMail installation, the Initialization wizard prompts users for any required information that 
was not already prepopulated.

b. Using the ViewMail Options or Settings dialog: Enter the required information. Provide users 
with instructions, if applicable. See the “Associating the Applicable Email Account with the 
Voicemail Server” section on page 11.

Task List for Upgrading to ViewMail for Outlook 8.5

Note If you are upgrading from a ViewMail for Outlook version earlier than 8.5, see the “Task List for 
Installing ViewMail for Outlook 8.5 for the First Time” section on page 6 instead. The older version is 
uninstalled automatically, and installing 8.5 is considered a new installation.

Do the following tasks in the order listed to upgrade an 8.5(x) version of ViewMail for Outlook to 
version 8.5(x).

1. Confirm that ViewMail requirements and prerequisites have been met. See the “Requirements” 
section on page 2 and the “Prerequisites” section on page 7.

2. Download ViewMail for Outlook from the Cisco Download Software website. See the 
“Downloading ViewMail for Outlook 8.5(x)” section on page 10. 

3. Optional: Customize ViewMail for Outlook setup for the upgrade, if applicable. See the 
“Customizing ViewMail for Outlook Setup” section on page 11.

4. Optional: Provide users with ViewMail for Outlook files for the upgrade.

5. Upgrade ViewMail for Outlook. Provide users with instructions, if applicable. See the “Installing or 
Upgrading to ViewMail for Outlook 8.5” section on page 11.

Note Existing email account and ViewMail for Outlook settings remain unchanged during an upgrade.

Prerequisites
• Prerequisites for Using ViewMail for Outlook with the Single-Inbox Feature, page 8

• Prerequisites for Using ViewMail for Outlook with IMAP, page 8

• Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users Only), 
page 9
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  Installation and Upgrade Information
Prerequisites for Using ViewMail for Outlook with the Single-Inbox Feature

For ViewMail for Outlook users who will access Connection voice messages by using synchronized 
Connection and Microsoft Exchange mailboxes (single inbox), confirm that the following prerequisites 
have been met:

• The single-inbox feature is enabled.

(See the Unified Messaging Guide for Cisco Unity Connection at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/unified_messaging/guide/85xcu
cumgx.html.)

• An Exchange email account in Outlook points to each user’s Exchange mailbox.

Prerequisites for Using ViewMail for Outlook with IMAP

For ViewMail for Outlook users who will access Connection voice messages by using IMAP, confirm 
that the following prerequisites have been met:

• Users’ corporate email addresses are configured as SMTP proxy addresses.

(See the “SMTP Proxy Addresses in Cisco Unity Connection 8.x” section in the “Setting Up 
Features and Functionality That Are Controlled by User Account Settings in Cisco Unity 
Connection 8.x” chapter of the User Moves, Adds, and Changes Guide for Cisco Unity Connection 
Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx.htm
l.)

• Users are associated with a class of service enabled for accessing voice messages by using an IMAP 
client.

(See the “IMAP Client Access to Voice Messages in Cisco Unity Connection 8.x” section in the 
“Setting Up Features and Functionality That Are Controlled by Class of Service in Cisco Unity 
Connection 8.x” chapter of the User Moves, Adds, and Changes Guide for Cisco Unity Connection.)

• The Connection server is configured to allow SMTP connections from IMAP clients.

(See the “Configuring the Cisco Unity Connection Server for IMAP Client Access and 
Authentication” section under “Procedures for Configuring IMAP Access in Cisco Unity 
Connection 8.x” in the “Configuring IMAP Settings in Cisco Unity Connection 8.x” chapter of the 
System Administration Guide for Cisco Unity Connection Release 8.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx
.html.)

• If Transport Layer Security for untrusted IP addresses is configured to be required or optional: The 
Connection server is configured to provide a secure IMAP connection.

(See the “Securing Cisco Unity Connection Administration, Cisco PCA, and IMAP Email Client 
Access to Cisco Unity Connection 8.x” section in the “Configuring SSL in Cisco Unity Connection 
8.x” chapter of the System Administration Guide for Cisco Unity Connection.)

• An IMAP email account is configured in Outlook for each ViewMail for Outlook user.

(See the “Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users 
Only)” section on page 9 of these release notes.)
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  Installation and Upgrade Information
Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users Only)

Do the applicable procedure—depending on the Outlook version—for ViewMail for Outlook users who 
will access Connection voice messages by using IMAP:

• To Create and Configure an Account in Outlook 2010 to Access Voice Messages (IMAP Users), 
page 9

• To Create and Configure an Account in Outlook 2007 to Access Voice Messages (IMAP Users), 
page 9

• To Create and Configure an Account in Outlook 2003 to Access Voice Messages (IMAP Users), 
page 10

To Create and Configure an Account in Outlook 2010 to Access Voice Messages (IMAP Users)

Step 1 Start Outlook.

Step 2 On the File tab, select Info, then Add Account.

Step 3 Confirm that Email Account (the default) is selected, then enter user information:

a. In the Your Name field, enter a display name for the account. This typically is the full name of the 
user.

b. In the Email Address field, enter the Connection SMTP address of the user.

The address is available in the SMTP Address field on the User Basics page in 
Connection Administration, and typically uses the following format:

<username>@<SMTP domain name of the Connection server or cluster>

c. In the Password field, enter the user’s Cisco PCA password (also known as the web application 
password).

d. In the Retype Password field, enter the Cisco PCA password again.

Step 4 Select Next.

Step 5 If you see the “Problem Connecting to Server” message about an unavailable encrypted connection: 
Select Next to use an unencrypted connection.

Step 6 When the email-account configuration is complete, select Finish.

To Create and Configure an Account in Outlook 2007 to Access Voice Messages (IMAP Users)

Step 1 Start Outlook.

Step 2 From the Outlook Tools menu, select Account Settings.

Step 3 In the Account Settings dialog, on the Email tab, select New.

Step 4 In the Add New Email Account wizard, select Microsoft Exchange, POP3, IMAP or HTTP as the 
email service, then select Next.

Step 5 Enter user information:

a. In the Your Name field, enter a display name for the account. This typically is the full name of the 
user.

b. In the Email Address field, enter the Connection SMTP address of the user.
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The address is available in the SMTP Address field on the User Basics page in 
Connection Administration, and typically uses the following format:

<username>@<SMTP domain name of the Connection server or cluster>

c. In the Password field, enter the user’s Cisco PCA password (also known as the web application 
password).

d. In the Retype Password field, enter the Cisco PCA password again.

Step 6 Select Next.

Step 7 If you see the Problem Connecting to Server message about an unavailable encrypted connection: Select 
Next to use an unencrypted connection.

Step 8 When the email-account configuration is complete, select Finish.

To Create and Configure an Account in Outlook 2003 to Access Voice Messages (IMAP Users)

Step 1 Start Outlook.

Step 2 From the Outlook Tools menu, select Email Accounts.

Step 3 In the Email Accounts wizard, under Email, select Add a New Email Account, then select Next.

Step 4 Under Server Type, select IMAP as the email service, then select Next.

Step 5 On the Internet Email Settings (POP 3) dialog, enter the applicable information in the User, Server, and 
Logon sections, then select Next.

Step 6 When the email-account configuration is complete, select Finish.

Downloading ViewMail for Outlook 8.5(x)

To Download ViewMail for Outlook 8.5(x)

Step 1 On a computer with a high-speed Internet connection, go to the Voice and Unified Communications 
download page at http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=278875240.

Note To access the software download page, you must be signed in to Cisco.com as a registered user.

Step 2 In the tree control on the download page, expand Products>Voice and Unified Communications>IP 
Telephony>Unified Messaging>Cisco Unity Connection, and select Cisco ViewMail for Microsoft 
Outlook Version 8.5.

Step 3 In the Latest Releases folder, select VMO 8.5(3).

Step 4 On the right side of the page, select Download Now, and follow the on-screen prompts to complete the 
download.
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Customizing ViewMail for Outlook Setup
The file AdminConfig.xml is available in the ViewMail for Outlook installation folder. Use the file to 
prepopulate user and voicemail server information when the ViewMail for Outlook installation or 
upgrade is being pushed out to users.

After entering information in AdminConfig.xml, leave the file in the ViewMail installation folder when 
you make it available to users.

Installing or Upgrading to ViewMail for Outlook 8.5
By default, ViewMail for Outlook files are installed in the directory C:\Program Files\Cisco 
Systems\ViewMail for Outlook. You can specify a different directory during the software installation.

Do the procedure in this section to install or upgrade ViewMail for Outlook on user workstations. You 
can also install ViewMail for multiple users who share a workstation.

To Install or Upgrade to ViewMail for Outlook 8.5

Step 1 If Microsoft Outlook is running, exit the application.

Step 2 In the ViewMail folder, double-click the applicable file:

Step 3 Follow the on-screen prompts to complete the installation.

Step 4 Restart Outlook.

Associating the Applicable Email Account with the Voicemail Server
You must link the applicable IMAP account or Exchange account with the voicemail server. This ensures 
that messages composed by using ViewMail for Outlook are sent to the voicemail server.

Do the following procedure on each user workstation.

To Associate an Email Account with a Voicemail Server

Step 1 In Outlook, open the ViewMail Settings or Options dialog:

Setup.exe Use this file for new installations and for upgrades from versions earlier than 8.5. It 
installs prerequisite software, as needed; places the AdminConfig.xml file in the 
correct location; and uninstalls older versions during upgrades.

ViewMail.msi Use this file for quick minor upgrades with versions 8.5 and later.

Outlook 2010 On the ViewMail tab, select Settings.

Outlook 2007 From the Tools menu, select Options, then the ViewMail tab.

Outlook 2003 From the Tools menu, select Options, then the ViewMail tab.
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  Limitations and Restrictions
Step 2 Select Add, then select the account to associate with a voicemail server.

Step 3 Enter the applicable information in each field:

Step 4 Select Test Settings to verify the information that was entered.

Step 5 Select OK.

Limitations and Restrictions
• Incompatibility with Exchange System Management Tools, page 12

• Installing a New Version of Outlook Requires Uninstalling ViewMail First, page 13

• Message Sensitivity Displays as Blank for Normal Sensitivity Messages Recorded in ViewMail, 
page 13

• Some Software on User Workstations Can Cause ViewMail to Fail, page 13

• To Compose Voice Messages, Connection Server Must Be Available, page 13

• ViewMail for Outlook 8.5 Limitations Regarding Secure Messages in Connection 8.0 and 7.x, 
page 13

Incompatibility with Exchange System Management Tools
ViewMail for Outlook version 8.5 does not work correctly when it is installed on a computer that also 
has Microsoft Exchange System Management Tools installed.

Table 1 ViewMail for Outlook Settings

Field Setting

Voicemail Server Type Select the voicemail server type to associate with the email account.

Username Enter the username (alias) of the user.

Password Enter the user’s Cisco PCA password (also known as the web 
application password).

Voicemail Server Name Enter the name of the voicemail server.

Voicemail Server Status Display only.

(Possible values are “Connected,” “Not Connected,” “Invalid 
Credentials,” and “Unknown.”)

Phone Number Enter the extension or a phone number for the user.

This setting is required only if you want the user to be able to record 
or play messages by using the phone.

Recording Device Select the preferred device.

Playback Device Select the preferred device.
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  Caveats
Installing a New Version of Outlook Requires Uninstalling ViewMail First
When installing a new version of Microsoft Outlook on user workstations, you must first uninstall 
ViewMail for Outlook. After you have installed Outlook, reinstall ViewMail.

Otherwise, ViewMail for Outlook will seem to be installed properly with the new version of Outlook, 
but it may not work.

Message Sensitivity Displays as Blank for Normal Sensitivity Messages 
Recorded in ViewMail

Users whose Outlook clients are configured to display the Sensitivity field in the message-list view may 
notice that messages recorded in ViewMail for Outlook with the Sensitivity set to Normal do not display 
any text in the Sensitivity field.

Messages recorded by using the Cisco Unity Connection phone interface (as well as email messages 
composed in Outlook) display “Normal” in the Sensitivity field.

Some Software on User Workstations Can Cause ViewMail to Fail
Some security and VPN software installed on user workstations may cause ViewMail for Outlook to fail. 
In particular, software that offers personal firewalls is problematic.

Exceptions may need to be added to the problematic software to allow ViewMail to work. Alternatively, 
you can set up ViewMail so that users can play messages with computer speakers.

To Compose Voice Messages, Connection Server Must Be Available 
In order to compose voice messages by using ViewMail for Outlook with Cisco Unity Connection 8.5, 
ViewMail must be able to contact the Connection server. If the server is not available, users will see the 
following message: “The requested action could not be performed because the voicemail server was not 
available.”

In earlier ViewMail versions, voice messages could be recorded while the Connection server was 
unavailable and were sent when the server became available again.

ViewMail for Outlook 8.5 Limitations Regarding Secure Messages in 
Connection 8.0 and 7.x

In Connection versions 8.0 and 7.x, users cannot reply to, forward, or compose secure messages by using 
ViewMail for Outlook version 8.5.

Caveats
You can find the latest caveat information for Cisco Unity Connection ViewMail for Microsoft Outlook 
version 8.5 by using Bug Toolkit, an online tool available for customers to query defects according to 
their own needs.
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  Obtaining Documentation and Submitting a Service Request
Bug Toolkit is available at www.cisco.com/go/bugs. Fill in your query parameters by using the custom 
settings in the Advanced Settings option.

Note To access Bug Toolkit, you must be logged on to Cisco.com as a registered user.

Release notes for all versions of ViewMail for Outlook are available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS Version 2.0.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of 
Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The 
use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any 
examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. 
Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

© 2010 Cisco Systems, Inc. All rights reserved.
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